
 
 

IRS Factors Calculator 
Software and User Manual 

Copyright © 1998-2000, Brentmark Software, Inc., All Rights Reserved. 

 

8/25/2000 

 

Brentmark® Software, Inc. 

3505 Lake Lynda Drive, Suite 212 

Orlando, FL 32817-8327 

 

Sales 

1-800-879-6665 

Technical Assistance 

407-306-6160 

Fax 

407-306-6107 

 

www.brentmark.com 

sales@brentmark.com 

support@brentmark.com 

comments@brentmark.com 

 



  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

. 



i 

Table of Contents 

Chapter 1 7 

Introducing the IRS Factors Calculator ............................ 7 

Welcome to the IRS Factors Calculator 7 

Installation 7 
Installing the Program 7 
Uninstalling the Program 8 

What do I See on the Screen? 8 
Title Bar 8 
Menu Bar 8 
Toolbar 8 
Data Input Buttons 9 
Results Box 9 
Hint Line 9 

Shortcut Keys 9 

Chapter 2 11 

Working with Files .......................................................... 11 

Frequently Used Procedures 11 
Create a New File 11 
Open an Existing File 11 
Save a File 11 
Save an Existing File (Save As) 11 
Clear Data Entry 12 
Exit the Program 12 
Update the AFR Table Manually 12 
Download AFR Rates 12 
Turn Off Required §7520 Rate Rounding 12 



IRS Factors Calculator 

ii  

Chapter 3 13 

Calculating Annuity, Life Estate and Remainder Factors13 

Factors Section 13 

Private Annuity 14 

Life Estate 15 

Remainder Interest 15 

Chapter 4 17 

Calculating Taxable Gift Values for GRATs..................... 17 

GRAT Section 17 

Grantor Retained Annuity Trust (GRAT) 18 

Chapter 5 23 

Calculating Taxable Gift Values for GRUTs .................... 23 

GRUT Section 23 

Grantor Retained Unitrust (GRUT) 24 

Chapter 6 29 

Calculating Taxable Gift Values for GRITs/QPRTs.......... 29 

GRIT/QPRT Section 29 

GRIT/Qualified Personal Residence Trust (QPRT) 30 



Table of Contents 

iii 

Chapter 7 33 

Calculating Last-To-Die, One Survives Another, and First-To-Die 
Factors............................................................................ 33 

Examples Section 33 

Chapter 8 35 

Calculating Factors Using IRS Tables ............................ 35 

Tables Section 35 

IRS Tables 36 

Chapter 9 37 

Viewing, Formatting, and Printing Reports..................... 37 

Calculation Results 37 

Report Options Window 37 
Access the Report Options Window 37 
Create a Heading for a Report 37 
Include the Heading on Printed Reports 37 
Format the Text of a Report 38 
Format Page Margins 38 
Print the Date and Time 38 

Print Preview Window 39 
Preview Reports 39 

Printing Window 39 
Access the Printing Window 39 
Print a Report 40 
Save a Report as a Text File 40 
Save a Report as a Spreadsheet File 40 
Set up a Printer 40 



IRS Factors Calculator 

iv  

Chapter 10 41 

Reference Material ......................................................... 41 

§2702 41 

Applicable Federal Rates 41 
Update the AFR Table Manually 42 
Download AFR Rates 42 
Turn Off Required §7520 Rate Rounding 43 
Print the AFR Table 43 
Save the AFR Data File to Another Location 43 

Calculation Types 44 

Exhausting Annuities 45 
Exact Method 46 
Annuity Factor Method 46 

IRS Notice 89-60 47 

Reg. §25.7520-3(b)(2)(v), Example 5 49 

Treasury Decision 8819 50 

Chapter 11 53 

Getting Help.................................................................... 53 

Help Menu 53 

Help System 53 

Technical Support 53 

Program Updates 54 



Table of Contents 

v 

License Agreement 55 

Index 57 

 



IRS Factors Calculator 

vi  



7 

Chapter 1 
Introducing the IRS Factors Calculator 

Welcome to the IRS Factors Calculator 

This program completely eliminates your need to wade through the IRS publication 1457 (7-
1999), the Aleph volume. The IRS Factors Calculator calculates the values of annuities, life 
estates, and remainders (term, one, or two lives). The program includes all of the examples 
contained in the Aleph volume and calculates all of the factors contained in the following tables: 
Table H (Aleph, Alpha), Table C (Gimel), Table K, Table 80CNSMT, Table 90CM, Table V, and 
Table VI. The IRS Factors Calculator also calculates the taxable gift values for Grantor Retained 
Income Trusts (GRITs)/Qualified Personal Residence Trusts (QPRTs), Grantor Retained Annuity 
Trusts (GRATs), and Grantor Retained Unitrusts (GRUTs). The program includes a table of the 
IRS’ Applicable Federal Mid-Term 120% Annual Rates (AFRs) from 1989, so it’s easy for you to 
find a past rate or update the table monthly. 

All calculations are independent of each other. That means you don’t have to worry about data 
transferring between sections as you switch from calculating a remainder to calculating a factor 
from Table H.  

Results appear in the same window as your data entry, and you can even format and print the 
results as reports for your clients. 

Installation 

Getting started with the IRS Factors Calculator is easy. Before you install the program, be sure 
that you’re running a Windows 95 or later operating system. The IRS Factors Calculator does not 
run on Windows 3.1 or earlier operating systems. 

Installing the Program 

1. Insert the disk into the disk drive. 

2. On the Windows Taskbar, click the Start button. 

3. On the Start menu, click Run. The Run dialog box appears. In the Open box, 
A:\SETUP.EXE should appear. If it doesn’t, type A:\SETUP.EXE. 

4. Click OK. 

5. The setup program begins. Follow the instructions in the setup program. 
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Uninstalling the Program 

1. On the Windows Taskbar, click the Start button. 

2. Point to Settings and click Control Panel. The Control Panel window appears. 

3. Click Add/Remove Programs. The Add/Remove Program Properties dialog box 
appears. 

4. Use the scrollbar to find the Pension Distributions Calculator. When you find it, click the 
program title. Notice that the Add/Remove button is now functional. 

5. Click the Add/Remove button. The uninstall program begins. Follow the instruction in 
the uninstall program. 

What do I See on the Screen?         

When you run the program, the IRS Factors Calculator window opens.  

Title Bar 

The title bar appears at the top of the window. It contains the following information. 

• Program title 

• Program version number 

• Input section title 

• File name (if the file has been saved) 

Menu Bar 

The Menu bar is below the title bar. The Menu bar contains three menus you use to select 
program commands.  

 

Toolbar 

The toolbar is below the Menu bar. The toolbar contains graphics as commands. You can click 
these graphics instead of using the related Menu bar commands. 

 

 
Open Files 

Save Files Print Files 

Open AFR Table Access Web 

Get Help 
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Data Input Buttons 

In the left side of the window, six buttons appear. Use these buttons to access the data entry 
sections of the program. As you click each button, its corresponding data input section appears in 
the right side of the window.  

Results Box 

Below each data entry section is a results box. As you enter information, you can see the results 
of the calculations, all in one window. 

Hint Line 

At the bottom of the screen is the Hint line. As you move the pointer over input boxes or other 
areas of the window, the Hint line displays a description or instructions for the box or area. 

Shortcut Keys 

Use the function keys for frequently used program commands. 

 

F1 Access the online help system. 

F2 Save files. 

F3 Open files. 

F4 Access the AFR table. 

F7 Clear data. 

Alt C Access Help Contents. 

Alt S Search Help Index. 

Alt U Learn how to use Help. 

Alt X Exit the program. 

Ctrl P Print files. 

Ctrl R Access Report Options. 

Ctrl S Save file as another name. 

Ctrl T Set up a printer. 

Ctrl V Preview reports 
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Chapter 2 
Working with Files 

Frequently Used Procedures 

Refer to this chapter to view instructions for procedures that you’ll frequently use when working 
with files. 

Create a New File 

• On the File menu, click New. The program clears all previous data entry and resets the 
program's default values. 

Open an Existing File 

1. On the File menu, click Open. Or on the toolbar, click the Open graphic. The Open 
dialog box appears. 

2. In the File name box, enter the name of the file and proper extension. Be sure you have 
selected the proper drive and folder of your file. 

Save a File 

1. On the File menu, click Save. Or on the toolbar, click the Save graphic. The Save dialog 
box appears. 

If the file has not been saved before, the Save As dialog box appears. 

2. Select the drive and folder in which to save the file. 

3. In the File name box, type a name for the file. The program automatically adds the 
proper extension to the file name. 

Save an Existing File (Save As)  

1. Open an existing file or create a new file. 

2. On the File menu, click Save As. Or on the toolbar, click the Save graphic. The Save As 
dialog box appears. 

3. Select the drive and folder in which you want to save the file. 

4. In the File name box, enter a name for the new file. The program automatically adds the 
proper extension to the file name. 
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Clear Data Entry 

1. On the Edit menu, click Clear Inputs. A Warning appears. 

2. Click Yes to reset the default values. If you click No, you will not clear your data. 

Exit the Program  

• On the File menu, click Exit. The program closes. 

Note 
Be sure to save any open files before clicking the Exit command. 

Update the AFR Table Manually 

1. In the AFR Table, click the table cell corresponding to the year and month that you want 
to update. 

2. Enter the AFR. You can find the AFRs in the Wall Street Journal. See the Federal 
Interest Rates in the Money and Investing section of the Journal, generally between the 
18th and 23rd of the preceding month. Or visit the Brentmark website at 
www.brentmark.com 

3. Press Enter or click another box to confirm your entry. The program automatically saves 
your entries. 

Download AFR Rates 

1. Open the AFR Table. 

2. Click Download Latest AFRs. A Confirm message appears. 

3. Click Yes to begin updating the AFR Table from the Brentmark website. 

Note 
If you have Internet access through an Internet Service Provider (ISP) such as AOL, Compuserve, or 
Prodigy, you must establish connection through your ISP before downloading the AFRs. If you’re connected 
to the Internet through a network or a cable modem, your Internet connection is already established. 

Turn Off Required §7520 Rate Rounding 

The calculations in this program require you to use AFR rates. When you enter AFRs, the 
program follows the IRS practice of rounding the rate up to the nearest two tenths of one percent 
(as per Code §7520). For example, 10.10% rounds to 10.2%. You can find appropriate rates in the 
AFR Table.  You can, however, turn rounding off. 

• To turn off the required rounding, on the Edit menu, click Turn Off Required §7520 
Rounding. When you turn of rounding, the words No Rounding appear next to the 
§7520 Rate box. 

Note 
You cannot turn off rounding for the GRAT, GRUT, GRIT/QPRT calculations. 
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Chapter 3 
Calculating Annuity, Life Estate and Remainder Factors 

Factors Section 

Click the Factors button on the left side of the window to calculate Annuity, Life Estate and 
Remainder Factors. An image of the Factors section appears below. The program only allows you 
to enter the data appropriate to the type of calculation that you select. 

 

 
Input  Description 

Annuity Factors Click this radio button to calculate Annuity Factors. 

Life Estate & Remainders Click this radio button to calculate Life Estate & Remainder 
Factors. 

Transfer Date Enter the month and year that the transfer takes place. For 
example, enter 8/1999 for August 1999. If Transfer Date is 
5/1999 or 6/1999, the Table box appears. Click the Mortality 
table that you want to use. For dates prior to May 1, 1999, the 
program automatically uses the 80CNSMT mortality table. For 
dates after June 30,1999, the program automatically uses the 
90CM mortality table. For more information, see Treasury 
Decision 8819. 

§7520 Rate In the §7520 Rate box, enter an AFR rate. Notice that the 
program automatically displays the rate that is most favorable. 
You can override the program’s value by entering another rate. If 
the box displays 30%, you need to update the AFR Table. 
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Calculation Type Select the type of calculation that determines how long the 
grantor will receive annuities. See the discussion of Calculation 
Types in Chapter 10, Reference Material. 

Aggregate Annual 
Payments/Principal 

Enter the total payments for the year. If you’re calculating a Life 
Estate or Remainder, this box is labeled Principal. Enter the 
value of all assets in the fund. 

Payment Timing Click Begin if annuities are paid at the beginning of the year. 
Click End if annuities are paid at the end of the year. 

Lives Enter the number of lives on which the trust is based. 

Age Enter the age of the grantor. 

Second Age Enter the age of the second person on whom the trust is based. 

Term Enter the number of years for which the trust has been 
established. 

Sensitivity Report Click the Sensitivity Report? check box to view results in a 
sensitivity report. 

Private Annuity 

A private annuity is an agreement between two parties. One party (the transferor-annuitant) signs 
over complete ownership of property to another party (the transferee-payer). In return, the 
transferee makes periodic payments to the transferor for a specified period of time (usually the 
lifetime of the transferor). 

The private annuity is a useful tool for an individual who wants to spread out, over his or her 
lifetime, payments from selling a highly appreciated asset.   

The private annuity is also a useful federal estate tax saving tool because payments end when the 
transferor dies, and the entire value of the asset sold is immediately removed from the transferor's 
gross estate. The private annuity allows someone who owns non-income-producing property to 
make that property productive. 

• The ideal situation is one that meets the following criteria: 

• The transferor is in a high estate tax bracket or has no marital deduction. 

• The property is capable of producing income and/or is appreciating rapidly.  

• The payer is capable of paying the promised amounts. 

• The parties trust each other (the private annuity must be unsecured). 

• The transferor has other assets and sources of income. 
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Single & joint life annuity factors are used for private annuities, charitable remainder annuity 
trusts and charitable gift annuities. These life annuity factors are adjusted by a period factor when 
payments are made other than at the end of an annual period. If payments start at the beginning of 
a period, the value includes the first payment. 

Term certain annuity factors are used for charitable remainder annuity trusts. The term certain 
annuity factor is adjusted by a period factor when payments are made other than at the end of an 
annual period. Different period factors are used when payments start at the beginning or end of 
the period. 

Life Estate 

A life estate is the right to use, possess, and enjoy property or the income it produces for the life 
of a specified person. That measuring life can be the life of the holder of the interest or may be 
measured by the life of some other person. A life estate can be payable for more than one life. For 
example, the right to live on or enjoy the income from property (in or out of trust) can extend for 
the joint lives of the client and his spouse. The life income beneficiary receives no right to enjoy 
the principal. A life estate ends at the death of the measuring life. But if one person holds a life 
estate  (parent) and another person is used as the measuring life (child), the holder of the estate 
could give it away, sell it, or leave it in his or her will. Then the life estate continues in the new 
owner’s hands—until the death of the measuring life  

Remainder Interest 

A remainder interest is the right to use, possess, or enjoy property when the prior interest (term or 
life) ends. Typically, a remainder interest is valued by subtracting the present value of the prior 
interest from the fair market value of the property. 
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Chapter 4 
Calculating Taxable Gift Values for GRATs 

GRAT Section 

Click the GRAT button on the left side of the window to calculate taxable gift values for GRATs. 
An image of the GRAT section appears below. 

 
Input  Description 

Transfer Date Enter the month and year that the transfer takes place. For 
example, enter 8/1999 for August 1999. If Transfer Date is 
5/1999 or 6/1999, the Table box appears. Click the Mortality 
table that you want to use. For dates prior to May 1, 1999, the 
program automatically uses the 80CNSMT mortality table. For 
dates after June 30,1999, the program automatically uses the 
90CM mortality table. For more information, see Treasury 
Decision 8819. 

§7520 Rate In the §7520 Rate box, enter an AFR rate. Notice that the 
program automatically displays the rate that is most favorable. 
You can override the program’s value by entering another rate. If 
the box displays 30%, you need to update the AFR Table. 

Calculation Type Select the type of calculation that determines how long the 
grantor will receive annuities. See the discussion of Calculation 
Types in Chapter 10, Reference Material. 

Principal Enter the fair market value of the assets in the trust. 

Percentage Payout Enter the percentage of the trust that grantor receives annually. 
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Annual Payment Growth Enter the annual percent increase of the assets in the trust. 

Payment Period Select the frequency of annuity payments. 

Payment Timing Click Beginning if annuities are paid at the beginning of the year. 
Click Ending if annuities are paid at the end of the year. 

Grantors Age(s) Enter the age(s) of the person(s) that are measuring the trust. If 
only one age is being used to measure the trust, enter zero in the 
box on the right side. 

Term Enter the number of years for which the trust has been 
established. 

Exhaustion Method Click IRS or Exact. See Exhausting Annuities in Chapter 10, 
Reference Material. 

Apply §2702? Click Yes or No. See §2702 in Chapter 10, Reference Material. 

Reversion? Click Yes if any assets will return to the grantor’s estate. Click 
No if the no assets will return to the grantor’s estate. 

Grantor Retained Annuity Trust (GRAT) 

A Grantor Retained Annuity Trust (GRAT) provides the grantor with a fixed annuity interest in 
an irrevocably transferred property. The remainder interest generally passes to the grantor’s 
designated beneficiaries at the end of a specified term or at the earlier of the end of a specified 
term or the grantor’s death. 

GRATs provide a fixed annuity payment, usually expressed as a fixed percentage of the original 
value of the assets transferred in trust. For example, if $100,000 is placed in trust and the initial 
annuity payout rate is 6 percent, the trust would pay $6,000 each year, regardless of the value of 
the trust assets in subsequent years. If income earned on the trust assets is insufficient to cover the 
annuity amount, the payments will be made from principal. Therefore, the client-transferor is 
assured steady and consistent payments (at least until principal is exhausted). 

All income and appreciation in excess of that required to pay the annuity accumulate for the 
benefit of the remainder beneficiary(ies). Consequently, it may be possible to transfer assets to 
the beneficiary(ies) when the trust terminates with values that far exceed their original values 
when transferred into the trust and, more importantly, that far exceed the gift tax value of the 
transferred assets. 

The gift tax value of the transferred assets is determined at the time the trust is created and funded 
using the “subtraction method. The gift tax value is determined by subtracting the value of the 
annuity interest (and, in some cases, other retained interests, such as the right to have the assets 
revert back to the transferor's estate if he or she does not live the entire term of the trust) from the 
fair market value of the assets transferred in trust. The ways in which annuity interest and any 
other retained interests are valued depend on who the remainder beneficiary(ies) is (are) and who 
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retains the annuity and other interests relative to the transferor. There is a more restrictive and 
less appealing set of valuation rules when family members are beneficiaries and certain family 
members retain interests in the property both before and after the trust is created than when 
unrelated parties are involved. 

When unrelated parties are involved, all interests are valued according to their actuarial present 
values using the valuation rules of IRC §7520. These rules mandate the use of a discount rate 
based on the 120% Applicable Federal Annual Midterm Rate for the month in which the trust is 
created and funded. The mortality factors from Table 80CNSMT or Table 90CM, if the interests 
have a life contingency, are also used.  

Note 
For May or June of 1999, you had the choice of using the Mortality Table 80CNSMT or the Mortality Table 
90CM. For any dates prior to May 1, the program will automatically use the 80CNSMT mortality table. For 
any dates after June 30, the program will automatically use the 90CM mortality table.  

The 120% Applicable Federal Annual Midterm Rate changes monthly and is reported in the IRS's 
Cumulative Bulletin, in various tax services, and in various financial news publications such as 
The Wall Street Journal. (See Fed Interest Rates in the Money & Investing section, generally 
between the 18th and 23rd of the preceding month). You can also obtain this rate by visiting 
Brentmark's Web site at www.brentmark.com.  

If family members are involved, the gift tax valuation rules of IRC §2702 may apply. Under these 
rules, certain types of retained interests, such as the right to have trust assets revert to the 
transferor's estate in the event of the transferor's premature death, may be valued at zero when 
computing the gift tax value of the transfer. As a general rule, every retained interest but a 
“qualified interest is assigned a value of zero for gift tax valuation purposes. In the case of a 
GRAT, a qualified interest is the right to receive “fixed amounts payable annually, more 
frequently (a fixed annuity), or a qualified remainder interest. That is, any non-contingent 
remainder interest if all other interests in the trust consist of qualified retained interests (qualified 
annuities). 

The right to receive a “fixed amount means the annuity must be a specified fixed dollar amount or 
a fixed percentage of the initial value of the trust payable each year rather than merely the income 
produced by the assets in the trust. Although fixed payments throughout the term of the trust are 
the norm, final regulations define the term “fixed amount more liberally. They would permit the 
annuity payments to increase or decrease in a systematic manner each year without adverse gift 
tax consequences. However, the annuity amount may not increase by more than 20 percent over 
the prior year. For example, if the initial annuity payment is $1,000, the trust could provide that 
annuity payments in subsequent years increase by as much as 20 percent, to $1,200 in the second 
year, $1,440 the third year, and so on. If the transferor retains the right to the greater of a fixed 
amount or the trust income in each year for a term of years, the annuity will still be a qualified 
annuity. However, the right to the trust income, if any, in excess of the fixed amount is valued at 
zero for gift tax purposes. Thus, the retained interest is valued for gift tax purposes as if it did not 
include any rights to excess income. 

Term Calculations and the Regulations 

According to the Regulations, the retained annuity interest's value cannot exceed the actuarial 
value of an annuity for the shorter of the specified term or life, even if the trust instrument itself 
calls for payment of a term-certain annuity. Therefore, when you run a Term case with the 
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program, you will see three Taxable Gift values. The first is based solely on a Term Interest 
valuation (Taxable Gift 1) and is not supported by the Regulations. Some commentators suggest 
that this is the correct approach and that the Regulations are incorrect. The program then shows a 
Taxable Gift as per Reg. §25.2702-3(e), Ex. 5 (Taxable Gift 2) which is a shorter of term or life 
valuation. This more conservative value generally is a higher taxable gift value than would result 
otherwise. Finally, the program shows a Taxable Gift limited by Rev. Rul. 77-454 (Taxable Gift 
3). When the exhaustion test of Rev. Rul. 77-454 starts to kick-in, it generally results in an even 
higher taxable gift value. The possible application of Rev. Rul. 77-454 in Term cases is 
dependent on the viewpoint that one must use a shorter of term or life valuation to begin with. If 
one did not need to use such a valuation, there would appear to be no argument for applying Rev. 
Rul. 77-454 at all.  

Actuarially, the Example 5 values are rather straightforward unless you are running a case 
involving a payment made at the beginning of the period. For such cases, we use a Shorter of 
Term or Life calculation that has one less payment than usual. This is done to equalize the 
number of payments for the Shorter case with the Term case. Term cases with a payment at the 
beginning are valued actuarially by the IRS by simply adjusting the Frequency Adjustment 
Factor. For example, a two-year semiannual term valuation involves four payments at points 0, ½, 
1 and 1½. However, Shorter of Term or Life cases (and for that matter, all cases with life 
contingencies) with a payment at the beginning of period are valued by the IRS by adding a 
payment to the normal end of the period valuation. For example, a two year semiannual shorter of 
term or life calculation involves five payments at points 0, ½, 1, 1½ and 2. Our revised Ex. 5 
calculations eliminate the last payment (the one at point 2 in our example) by using a pro-rata 
valuation for a one-year case and a two-year case to eliminate the last payment. This valuation 
approach is based on informal consultations with the National Office of the IRS.  

For all three GRAT calculation types, the program includes a Rev. Rul. 77-454 test (also known 
as the “exhaustion test). The program also shows Taxable Gift if the value of Rev. Rul. 77-454 is 
ignored (some commentators suggest Rev. Rul. 77-454 is incorrect although it is now part of the 
§7520 Regs.). It then shows the Taxable Gift limited by Rev. Rul. 77-454. Often the values are 
the same. However, if the Rate of Annuity is higher than the Sec. 7520 rate, the Taxable Gift 
under Rev. Rul. 77-454 will often be higher. In some cases where the Annual Payment Growth 
value is negative, the Rev. Rul. 77-454 Taxable Gift value may actually be lower.  

Rev. Rul. 77-454 Test 

When Rev. Rul. 77-454 may apply for a Shorter of Term or Life calculation, the program 
includes a year-by-year Rev. Rul. 77-454 schedule. As for the mechanics of the 77-454 test, there 
are gray areas once you get beyond the simple case of an annual payment at the end of the period. 
The program uses an approach long followed for the similar Rev. Rul 77-374 test that is applied 
for Charitable Remainder Annuity Trust life cases. See George H. Moor Est., 43 TCM 1982-299, 
for the proposition that annual payments are adjusted by a payout frequency factor.  

For the Shorter Calculation with Gift 2 selected for the Near Zero-Out option, the program finds 
the Rev. Rul. 77-454 value which does not increase the Taxable Gift beyond what it would be 
under Gift 1 (i.e., the Taxable Gift before consideration of Rev. Rul. 77-454). 
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§2702 Rules 

The more restrictive valuation rules apply if the transfer is to or for the benefit of a “member of 
the transferor's family and an interest in the trust is “retained by the transferor or an “applicable 
family member. A member of the transferor's family includes the transferor's spouse, ancestor, 
lineal descendent, an ancestor or lineal descendent of the spouse of the transferor, a brother or 
sister, and the spouse of any of these. A retained interest means a property interest held by the 
same individual both before and after the transfer in trust. An applicable family member is 
defined as the transferor's spouse, an ancestor of the transferor or an ancestor of the transferor's 
spouse, and the spouse of any such ancestor. 

In summary, if the §2702 rules apply, the annuity must be for a fixed amount or a fixed 
percentage of the initial value of the trust for a specified term. The annuity will be considered for 
a qualified “fixed amount if the scheduled payment in any year does not exceed 120 percent of 
the prior year's payment. The specified term may be the life of the annuitant, a fixed term or the 
shorter of a fixed term or the life of the annuitant. Regardless of the specified term, the annuity is 
valued for gift tax purposes as if it were for the shorter of a fixed term or the life of the annuitant. 

 

In other words, although the terms of the trust may specify that the annuity is to be paid for fixed 
and certain term of years, regardless of the survival of the annuitant, it must be valued for gift tax 
purposes as if it terminates upon the annuitant's death. Any other retained interest (other than the 
retention of a qualified remainder interest), including any rights to income or to a reversion of 
trust assets in the event of premature death, are valued at zero for gift tax purposes. Therefore, the 
gift tax value of the transfer is determined by subtracting the actuarial valued of the qualified life-
contingent annuity from the fair market value of the trust assets at the time the trust is created and 
funded. 

If the transferor-annuitant survives the term of the GRAT, the assets transferred in trust are not 
included in the transferor's gross estate and escape estate taxation. However, if the transferor dies 
during the term of the trust, some or all of the trust's assets will be included in the transferor's 
gross estate. Although there is no statutory or regulatory authority on the issue, some experts 
think the maximum amount the IRS could include is the lesser of the entire trust corpus or the 
amount of corpus required to provide the promised annuity for the term (without invading 
principal). 

This amount is computed by dividing the required annuity payment, for example, $20,000, by the 
§7520 rate as of the date of the transferor-annuitant's death, say 7.6%, to derive the required 
capital, in this instance, $263,158. A logical but more aggressive and uncertain argument can be 
made that the amount included should not exceed the present value of a term-certain annuity of 
the scheduled payments over the remaining term of the trust discounted at the §7520 rate. For 
example, if 3 years remained in the term of the trust, the present value of a $20,000 term-certain 
annuity discounted at 7.6% would be only $51,916. The risk of inclusion of trust assets should be 
covered by the purchase of life insurance owned by the appropriate beneficiary on the transferor's 
life. 

Since the GRAT permits payment of both income and trust principal to satisfy the transferor-
annuitant's annuity payments, the GRAT should be treated as a grantor trust for income tax 
purposes. This means the transferor-annuitant is taxed on income and realized gains on trust 
assets even if these amounts are greater than the trust's annuity payments. This further enhances 
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this tool's effectiveness as a family wealth-shifting and estate-tax-saving device. The transferor-
annuitant is effectively allowed to make gift-tax free gifts of the income taxes that are actually 
attributable to assets backing the remainder beneficiary's interest in the trust. 
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Chapter 5 
Calculating Taxable Gift Values for GRUTs 

GRUT Section 

Click the GRUT button on the left side of the window to calculate taxable gift values for GRUTs. 
An image of the GRUT section appears below. 

 

 
Input  Description 

Transfer Date Enter the month and year that the transfer takes place. For 
example, enter 8/1999 for August 1999. If Transfer Date is 
5/1999 or 6/1999, the Table box appears. Click the Mortality 
table that you want to use. For dates prior to May 1, 1999, the 
program automatically uses the 80CNSMT mortality table. For 
dates after June 30,1999, the program automatically uses the 
90CM mortality table. For more information, see Treasury 
Decision 8819. 

§7520 Rate In the §7520 Rate box, enter an AFR rate. Notice that the 
program automatically displays the rate that is most favorable. 
You can override the program’s value by entering another rate. If 
the box displays 30%, you need to update the AFR Table. 

Calculation Type Select the type of calculation that determines how long the 
grantor will receive annuities. See the discussion of Calculation 
Types in Chapter 10, Reference Material. 

Principal Enter the fair market value of the assets in the trust. 

Percentage Payout Enter the percentage of the trust that grantor receives annually. 
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Annual Payment Growth Enter the annual percent increase of the assets in the trust. 

Payment Period Select the frequency of annuity payments. 

Months Valuation Precedes 
Payout  

Enter the number of months between the annual valuation date 
and the date that the payout is made. This number directly relates 
to the frequency of payments: Enter 0 to 12 months for annual 
payment periods, 0 to 6 months for semiannual periods, 0 to 3 
months for quarterly periods, and 0 or 1 for monthly periods. 

Grantors Age Enter the age of the grantor. 

Term Enter the number of years for which the trust has been 
established. 

Apply §2702? Click Yes or No. See §2702 in Chapter 10, Reference Material. 

Reversion? Click Yes if any assets will return to the grantor’s estate. Click 
No if the no assets will return to the grantor’s estate. 

 

Grantor Retained Unitrust (GRUT)         

A Grantor Retained Unitrust (GRUT) provides the grantor with a fixed percentage of the value of 
the irrevocably transferred property (determined annually) for a fixed period of years. The 
remainder interest generally passes to the grantor’s designated beneficiaries at the end of a 
specified term or at the earlier part of the end of a specified term or the grantor’s death. 

GRUTs provide an annuity payment equal to a fixed percentage of the current value each year of 
the assets in trust. In this sense, a GRUT is similar to a variable annuity. The payout rate is fixed, 
but since the value of the assets can be expected to vary year to year, the dollar annuity payout 
also varies year to year. 

For example, if $100,000 is placed in trust and the annuity payout rate is 5 percent, the trust 
would pay $5,000 the first year. If the value of the assets in trust increase to $110,000 in the 
subsequent year, the payout would be $5,200, 5 percent of $110,000. If income earned on the 
trust assets is insufficient to cover the annuity amount, the shortfall in payments will be made 
from principal. All income and appreciation in excess of that required to pay the annuity 
accumulate for the benefit of the remainder beneficiary(ies). Consequently, it may be possible to 
transfer assets to the beneficiary(ies) when the trust terminates with values that far exceed their 
original values when transferred into the trust and, more importantly, that far exceed the gift tax 
value of the transferred assets.  

The gift tax value of the transferred assets is determined at the time the trust is created and is 
funded using the “subtraction method. To determine the gift tax value, subtract the value of the 
annuity interest (and, in some cases, other retained interests, such as the right to have the assets 
revert back to the transferor's estate if he or she does not live the entire term of the trust) from the 
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fair market value of the assets in trust. The valuation of the annuity interest and any other retained 
interests depends on who the remainder beneficiary(ies) is (are), and who retains the annuity and 
other interests relative to the transferor. There is a more restrictive and less appealing set of 
valuation rules when family members are beneficiaries and certain family members retain 
interests in the property both before and after the trust is created than when unrelated parties are 
involved.  

When unrelated parties are involved, all interests are valued according to their actuarial present 
values using the valuation rules of IRC §7520. These rules mandate the use of a discount rate 
based on the 120% Applicable Federal Annual Midterm Rate for the month in which the trust is 
created and funded. The mortality factors from Table 80CNSMT or Table 90CM, if the interests 
have a life contingency, are also used.  

Note 
For May or June of 1999, you had the choice of using the Mortality Table 80CNSMT or the Mortality Table 
90CM. For any dates prior to May 1, the program will automatically use the 80CNSMT mortality table. For 
any dates after June 30, the program will automatically use the 90CM mortality table. 

 The 120% Applicable Federal Annual Midterm Rate changes monthly and is reported in the 
IRS's Cumulative Bulletin, in various tax services, and in various financial news publications 
such as The Wall Street Journal. (See Fed Interest Rates in the Money & Investing section, 
generally between the 18th and 23rd of the preceding month). You can also obtain this rate by 
visiting Brentmark's Web site at www.brentmark.com.  

If family members are involved, the gift tax valuation rules of IRC §2702 may apply. Under these 
rules, certain types of retained interests, such as the right to have trust assets revert to the 
transferor's estate in the event of the transferor's premature death, may be valued at zero when 
computing the gift tax value of the transfer. As a general rule, every retained interest but a 
“qualified interest is assigned a value of zero for gift tax valuation purposes. In the case of a 
GRUT, a qualified interest is the right to receive (1) amounts that are payable annually or more 
frequently and are a “fixed percentage (annuity payout rate) of the fair market value of the 
property in the trust (as revalued annually) or (2) a qualified remainder interest, that is, any non-
contingent remainder interest if all other interests in the trust consist of qualified retained interests 
(qualified annuities).  

The annuity must be a fixed percentage of the fair market value of the trust assets as revalued 
each year rather than merely the income produced by the assets in the trust. Although payments 
equal to an unchanging “fixed percentage of the trust assets is the norm, final regulations define 
the term “fixed percentage more liberally. They would permit the annuity payout rate to increase 
or decrease in a systematic manner each year without adverse gift tax consequences. However, 
the annuity payout rate in any year may not be more than 120 percent of the prior year's payout 
rate.  

For example, the trust could provide that the annuity payout rate in each subsequent year would 
equal 120 percent of the prior year's rate. If the initial annuity payout rate is 5%, it could increase 
to 6% in the second year, 7.2% in the third year, and so on. If the transferor retains the right each 
year to the greater of a fixed percentage of the value of trust assets as revalued annually or the 
trust income for a term of years, the annuity will still be a qualified annuity. However, the right to 
the trust income, if any, in excess of the fixed percentage of trust assets is valued at zero for gift 
tax purposes. Thus, the retained interest is valued for gift tax purposes as if it did not include any 
rights to excess income.  
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Finally, under the §2702 rules, the retained annuity interests value cannot exceed the actuarial 
value of an annuity for the shorter of the specified term or life, even if the trust instrument itself 
calls for payment of a term-certain annuity. 

These more restrictive rules apply if the transfer is to or for the benefit of a “member of the 
transferor's family and an interest in the trust is "retained" by the transferor or an "applicable 
family member. A member of the transferor's family includes the transferor's spouse, ancestor, 
lineal descendent, an ancestor or lineal descendent of the spouse of the transferor, a brother or 
sister, and the spouse of any of these. A retained interest means a property interest held by the 
same individual both before and after the transfer in trust. An applicable family member is 
defined as the transferor's spouse, an ancestor of the transferor or an ancestor of the transferor's 
spouse, and the spouse of any such ancestor. 

In summary, if the §2702 rules apply, the annuity must be for a fixed percentage of the value of 
the trust assets as revalued each year for a specified term. The annuity will be considered for a 
qualified “fixed percentage if the scheduled payout rate in any year does not exceed 120 percent 
of the prior year's payout rate. The specified term may be the life of the annuitant, a fixed term, or 
the shorter of a fixed term or the life of the annuitant.  

Regardless of the specified term, the annuity is valued for gift tax purposes as if it were for the 
shorter of a fixed term or the life of the annuitant. In other words, although the terms of the trust 
may specify that the annuity is to be paid for fixed and certain term of years, regardless of the 
survival of the annuitant, it must be valued for gift tax purposes as if it terminates upon the 
annuitant's death. Any other retained interest (other than a retention of a qualified remainder 
interest), including any rights to income or to a reversion of trust assets in the event of premature 
death, are valued at zero for gift tax purposes. Therefore, the gift tax value of the transfer is 
determined by subtracting the actuarial value of the qualified life-contingent unitrust annuity from 
the fair market value of the trust assets at the time the trust is created and funded. 

If the transferor-annuitant survives the term of the GRUT the assets transferred in trust are not 
included in the transferor's gross estate and escape estate taxation. Although there is no statutory 
or regulatory authority on the issue, some experts think the maximum amount the IRS could 
include is the lesser of the entire trust corpus or the amount of corpus required to provide the 
promised unitrust amount for the term (without invading principal).  

This amount is computed by dividing the adjusted unitrust payout rate, for example, 5%, by the 
§7520 rate for the month of the transferor-annuitant's death, say 7.6%, to derive the proportion of 
the trust's corpus that is includable for estate tax purposes, in this instance, 65.79 percent. A 
logical but more aggressive and uncertain argument is that the amount included should not exceed 
the present value of the expected unitrust annuity payments at the scheduled adjusted payout rate 
over the remaining term of the trust, assuming the assets are invested at the §7520 rate. For 
example, if 3 years remain in the term of the trust, the present value of a unitrust annuity interest 
with a 5% adjusted payout rate is only 0.142625. In other words, only 14.2625 percent of the trust 
assets are actually economically required to fund the unitrust annuity payments over the 
remaining 3-year term. In any event, the risk of inclusion of trust assets should be covered by the 
purchase of life insurance owned on the transferor's life by the appropriate beneficiary.  

Since the GRUT permits payment of both income and trust principal to satisfy the transferor-
annuitant's unitrust annuity payments, the GRUT should be treated as a grantor trust for income 
tax purposes. This means the transferor-annuitant is taxed on income and realized gains on trust 
assets even if these amounts are greater than the trust's unitrust annuity payments. This further 
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enhances this tool's effectiveness as a family wealth-shifting and estate-tax-saving device. The 
transferor-annuitant is effectively allowed to make gift-tax free gifts of the income taxes that are 
attributable to assets backing the remainder beneficiary's interest in the trust.  

 

 

 

 



IRS Factors Calculator 

28  



29 

Chapter 6 
Calculating Taxable Gift Values for GRITs/QPRTs 

GRIT/QPRT Section 

Click the GRIT/QPRT button on the left side of the window to calculate taxable gift values for 
GRITs/QPRTs. An image of the GRIT/QPRT section appears below. 

 

 
Input Description 

Transfer Date Enter the month and year of the transfer. For example, 8/1999. If 
Transfer Date is 5/1999 or 6/1999, the Table box appears. Click the 
Mortality table that you want to use. For dates prior to May 1, 1999, 
the program automatically uses the 80CNSMT mortality table. For 
dates after June 30,1999, the program automatically uses the 90CM 
mortality table. For more information, see Treasury Decision 8819.  

§7520 Rate Enter an AFR rate. Notice that the program automatically displays the 
rate that is most favorable. You can override the program’s value by 
entering another rate. If the box displays 30%, you need to update the 
AFR Table. 

Term of Trust Enter the number of years for which the trust has been established.  

Number of Lives Enter the number of lives that on which the trust is based. If you enter 
2 or more, the Second Age box appears. 

Age/Second Age Enter the age of the grantor. If the Second Age box appears, enter the 
age of the second person on which the trust is based. 

Principal Enter the fair market value of the assets in the trust. 
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With Reversion? Click Yes if any assets will be returned to the grantor. Click No if 
assets will not return to the grantor.  

 

GRIT/Qualified Personal Residence Trust (QPRT) 

This calculation determines the gift tax implications of establishing a Grantor Retained Income 
Trust (GRIT) or Qualified Personal Residence Trust (QPRT). Through this trust, the grantor 
retains an income interest in irrevocably transferred property, and the remainder interest is passed 
to the grantor's beneficiaries. These computations can be used for both residence trusts and 
qualified residence trusts and for GRITs transferring property to non-family members.  

At the time the trust is funded, a future gift is made. The value of that gift is the excess of the 
value of the property transferred over the value of the interest retained by the grantor. The value 
of the retained interest is found by multiplying by the present value of an annuity factor for the 
number of years the trust will run.  

For example, assuming a 7.6% discount rate, if the trust will run for ten years and $100,000 is 
initially placed into the trust subject to a reversion, the value of the (nontaxable) interest retained 
by a 65 year old grantor would be $64,590.  

The value of the (gift taxable) remainder interest would be the value of the capital placed into the 
trust ($100,000) minus the value of the nontaxable interested retained by the grantor ($64,590). 
Therefore, the taxable portion of the grantor retained income trust gift would be $35,410. This 
remainder interest, by definition, is a future interest gift and will not qualify for the annual 
exclusion. The donor will have to utilize all or part of the remaining unified credit (or if the credit 
is exhausted, pay the appropriate gift tax). If the grantor's income interest lasts long enough, 
however, the value of his or her retained interest would approach—actuarially—100 percent. This 
would essentially eliminate any gift tax liability.  

The advantage of the GRIT is that it is possible for an individual to transfer significant value to 
family members but to incur little or no gift tax. In the example, the cost of removing $100,000 
from the gross estate (plus all appreciation from the date of the gift) is the use of $35,410 of 
unified credit.  

The GRIT is a “grantor trust. This means all income, deductions, and credits are treated as if there 
was no trust and these items were attributable directly to the grantor.  

The entire principal (date of death value) must be included in the estate of a grantor who dies 
during the term of the GRIT since he has retained an interest for a period which, in fact, will not 
end before his death. If any gift tax had been paid upon the establishment of the GRIT, it would 
reduce the estate tax otherwise payable. If the unified credit was used, upon death within the 
term, the unified credit used in making the gift would be restored to the estate (if the grantor's 
spouse consented to the gift, his or her credit would not be restored).  
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The estate's beneficiary (possibly through gifts received from the GRIT grantor) could purchase 
life insurance on the life of the grantor. Then, if the grantor should die during the term of the 
GRIT there would be sufficient cash to pay any estate tax.  

IRC Code §2702 has severely limited the use of GRITs. Non-family members can use GRITs for 
any type of asset for any term. Family members will find GRITs useful only when the property 
transferred is a personal residence or for some tangible property. 
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Chapter 7 
Calculating Last-To-Die, One Survives Another, and First-To-Die 

Factors 

Examples Section 

Click the Examples button on the left side of the window to calculate Last-To-Die, One Survives 
Another, First-to-Die, One Life and Term, Two Lives and Term, and Pooled Income Funds 
Factors. An image of the Examples section appears below. Depending on the Example type that 
you select, the inputs may vary slightly. 

 

 
Input Description 

Transfer Date Enter the month and year of the transfer. For example, 8/1999. If 
Transfer Date is 5/1999 or 6/1999, the Table box appears. Click the 
Mortality table that you want to use. For dates prior to May 1, 1999, 
the program automatically uses the 80CNSMT mortality table. For 
dates after June 30,1999, the program automatically uses the 90CM 
mortality table. For more information, see Treasury Decision 8819.  

§7520 Rate Enter an AFR rate. Notice that the program automatically displays the 
rate that is most favorable. You can override the program’s value by 
entering another rate. If the box displays 30%, you need to update the 
AFR Table. 

Age/Second Age Enter the age of the grantor. If the example uses two lives, enter the 
Second Age. 

Term Enter the number of years for which the trust has been established. 
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Yearly Return Enter the annual interest rate applied to the principal of the funds. 
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Chapter 8 
Calculating Factors Using IRS Tables 

Tables Section 

Click the Tables button on the left side of the window to calculate factors using the Tables shown 
in the image below. Depending on the Table that you select, the inputs may vary slightly. 

 

 
Input Description 

Transfer Date Enter the month and year of the transfer. For example, 8/1999. If 
Transfer Date is 5/1999 or 6/1999, the Table box appears. Click the 
Mortality table that you want to use. For dates prior to May 1, 1999, 
the program automatically uses the 80CNSMT mortality table. For 
dates after June 30,1999, the program automatically uses the 90CM 
mortality table. For more information, see Treasury Decision 8819.  

§7520 Rate Enter an AFR rate. Notice that the program automatically displays the 
rate that is most favorable. You can override the program’s value by 
entering another rate. If the box displays 30%, you need to update the 
AFR Table. 

Age/Second Age Enter the ages of for whom you are calculating factors. 
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IRS Tables 

Use the Tables button to calculate factors using the IRS tables that the program includes.  

 
Table Description 

Table H (Aleph, Alpha) Table H from IRS Publication 1457 (8-89) lists the Dx, , and  
factors. 

Table C (Gimel) Table C lists the factors for reducing assurances—based on Life 
Table 90CM. 

Table K Table K from IRS Publication 1457 (8-89) shows the adjustment 
factors for annuities payable at the end of annual, semi-annual, 
quarterly, monthly, and weekly periods. 

Table 80CNSMT Table 80CNSMT from IRS Publication 1457 (8-89) is a mortality 
table used to calculate annuity, life estate, and remainder factors. 

Table 90CM Table 90CM is also a mortality table used to calculate annuity, life 
estate, and remainder factors. As of May 1, 1999, the IRS released 
the 90CM mortality table. This table replaces the older 80CNSMT. 
Between May 1, 1999 and June 30, 1999 you can use either the 
80CNSMT or the 90CM. After June 30, 1999, do not use the 
80CNSMT (REG-103851-99). 

Table V Table V from Regulation Section 1.72-9 is used to calculate life 
expectancy factors when dealing with minimum distributions from a 
qualified pension plan or IRA. 

Table VI Table VI lists the multiples used to calculate life expectancies when 
dealing with distributions from a qualified pension plan or IRA.  
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Chapter 9 
Viewing, Formatting, and Printing Reports 

Calculation Results 

IRS Factors Calculator results appear in the same window as your data entry. You can print a 
report for each calculation. Also you can format and preview each report before printing. 

Report Options Window 

Use the Report Options window to format your reports for printing. The Report Options window 
allows you to create headings, format text and layout, and include other options for printing. 

Access the Report Options Window 

• On the File menu, click Report Options. 

Create a Heading for a Report 

You may want to create a heading that includes client names, your name, or a description of the 
report. 

1. In the Report Options window, click the Heading box. 

2. Type the text that you want to display at the top of your printed report. 

Include the Heading on Printed Reports 

• In the Printing Options group box, click the Print Heading check box. 
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Format the Text of a Report 

Use the Fonts group box in the Report Options window to format the text of your reports. The 
Fonts group box contains three types of text to format: Title, Body Text, and Headers. The name 
of the font and its size appear next to each type. The text appears the color as it will on the printed 
report. 

1. In the Fonts group box, click the text (Title, Body Text, or Headers) that you want to 
format. The Font dialog box appears. 

2. Format the Font, Style, Size, and Effects of the text and click OK.  

3. Notice the description of the text in the Report Options window has changed. 

Format Page Margins  

Use the Page Margins group box in the Report Options window to format the layout of your 
reports. The Page Margins group box contains boxes for you to enter top, bottom, left, and right 
page margins.  

• In the Page Margins group box, enter the Top, Left, Bottom, and Right margin settings 
(in inches).  

Print the Date and Time 

• In the Printing Options group box, click the Print Date and/or Print Time check boxes. 
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Print Preview Window 

Use the Print Preview  window to view reports before printing. If you’ve formatted your report 
using the Report Options window, the Print Preview window allows you to view the changes 
you’ve made before printing. If you don’t like what you see, you can always go back and 
reformat the report.  

Preview Reports 

• Click Print Preview on the File menu. 

• Click Print Preview from the Printing window. 

 

The Print Preview window has its own toolbar. Following are descriptions of the toolbar 
commands. 

 
Button Description 

<Page Click this button to display the previous page. 

Page> Click this button to display the next page. 

Fit Click this button to display the entire page in the window. 

100% Click this button to display the page at its actual size. 

Print Click this button to print the report. You will not have the option of formatting 
the report. 

Printing Window 

Use the Printing window to print reports. You can print a report for each one of the program’s 
calculations. The Printing window also allows you to save a report as a text or spreadsheet file. 

Access the Printing Window  

There are two ways to access the printing window: 

• On the File menu, click Print. 

• On the toolbar, click the printer graphic. 
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Print a Report 

1. On the File menu, click Print. Or on the toolbar, click the print graphic. The Printing 
window appears. Notice that the program displays the selected printer. 

2. Click the Date and Time check boxes to include the date and time on the report. 

Save a Report as a Text File 

1. In the Printing window, click Print to Text File. The Save As dialog box appears. 

2. From the Save in drop-down list, select the drive and folder in which you would like to 
save the file. 

3. In the File name box, enter a name for the report file. The program saves the file with a 
.txt extension. 

Save a Report as a Spreadsheet File 

1. In the Printing window, click Print to WK1 File. The Save As dialog box appears. 

2. From the Save in drop-down list, select the drive and folder in which you would like to 
save the file. 

3. In the File name box, enter a name for the report file. The program saves the file with a 
.wk1 extension 

Set up a Printer 

1. Click Printer Setup on the File menu or in the Printing window. 

2. For help using the Print Setup dialog box, click  in the title bar. 

3. Move the cursor to the item with which you need help and click. A Help topic for that 
item appears.
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Chapter 10 
Reference Material 

§2702 

Section 2702 provides that all retained interests in trusts that are not “qualified interests are 
valued at zero. The amount of any gift is then determined by subtracting from the value of the 
property the value of the retained interest. The valuation of retained interests in trust under §2702 
specifically does not apply to incomplete gifts (determine without regard to whether there is 
consideration), personal residence trust, and charitable lead trusts. This occurs if the only interest 
other than the remainder or a qualified annuity or unitrust interest is the charitable lead interest. 

Section 2702 also does not apply to assignment of remainder interests in trusts if the only retained 
interest is distribution of income in the sole discretion of an independent trustee, as defined in 
Code section 674(c), and certain property settlement agreements. 

The following definitions apply under §2702: 

• A member of the family includes the spouse of an individual, the ancestor, lineal 
descendant, sibling of an individual, the individual’s spouse, the spouse of any such 
person, or the brother or sister of the individual. 

• An applicable family member includes the spouse of an individual, an ancestor of the 
individual or the individual’s spouse, or the spouse of any such person. 

• A transfer in trust includes a transfer to a new trust or an interest in an existing trust. But, 
it is not a transfer resulting from exercise of a special power of appointment, exercise, 
release, or lapse of a power of appointment that would not constitute a taxable gift (e.g., 
lapse of Crummey power which does not exceed 5 or 5 limitation) or a disclaimer. 

• A retained interest is one held by the same individual both before and after the transfer to 
the trust, or it is a carved out term interest. 

Applicable Federal Rates  

Prior to May 1, 1989, a 10% interest rate was used to generate IRS factors for annuities, life 
estates and remainders. For May 1, 1989 or later transfers, the applicable interest rate changes 
each month and is determined by reference to the 120% Annual Mid-Term Applicable Federal 
Rate (AFR). 

The calculations in this program require you to use AFR rates. When entering AFRs, the program 
follows the IRS practice of rounding the rate up to the nearest two tenths of one percent (as per 
Code Section 7520). For example, 10.10% rounds to 10.2%. You can find appropriate rates in the 
AFR Table.  However, in some cases, you can turn rounding off. 
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When you loaded the IRS Factors calculator, you also loaded the AFR Table, a separate 
application that stores previous and present AFR rates. The AFR Table works seamlessly with the 
IRS Factors Calculator. You can use the AFR Table to view or print AFRs or to enter AFRs as 
they are released each month by the government. The AFR Table saves your entries in its own 
data file. You can save this data file to another location, such as a network directory. Placing the 
AFR Table on a network enables your whole office to use the data file, even if a Brentmark 
product is not being used.  

While using IRS Factors Calculator, if the §7520 Rate box displays 30%, you must update the 
AFR Table. Thirty percent is the default value that appears when there is not a current AFR rate 
available for the chosen Transfer Date. You can update the AFR Table manually, or you can 
download the rates from www.brentmark.com. 

When you license the program, Brentmark has already programmed previous AFRs. You cannot 
change any of the entries that Brentmark has “locked in.   

Update the AFR Table Manually 

1. In the AFR Table, click the table cell corresponding to the year and month that you want 
to update. 

2. Enter the AFR. You can find the AFRs in the Wall Street Journal. See the Federal 
Interest Rates in the Money and Investing section of the Journal, generally between the 
18th and 23rd of the preceding month. Or visit the Brentmark website at 
www.brentmark.com 

3. Press Enter or click another box to confirm your entry. The program automatically saves 
your entries. 

Download AFR Rates 

1. Open the AFR Table. 

2. Click Download Latest AFRs. A Confirm message appears. 

3. Click Yes to begin updating the AFR Table from the Brentmark website. 

Note 
If you have Internet access through an Internet Service Provider (ISP) such as AOL, Compuserve, or 
Prodigy, you must establish connection through your ISP before downloading the AFRs. If you’re connected 
to the Internet through a network or a cable modem, your Internet connection is already established. 
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Turn Off Required §7520 Rate Rounding 

The calculations in this program require you to use AFR rates. When you enter AFRs, the 
program follows the IRS practice of rounding the rate up to the nearest two tenths of one percent 
(as per Code §7520). For example, 10.10% rounds to 10.2%. You can find appropriate rates in the 
AFR Table.  You can, however, turn rounding off. 

• To turn off the required rounding, on the Edit menu, click Turn Off Required §7520 
Rounding. When you turn of rounding, the words No Rounding appear next to the 
§7520 Rate box. 

Note 
You cannot turn off rounding for the GRAT, GRUT, GRIT/QPRT calculations. 

Print the AFR Table 

You may want to print the AFR table for your clients or to have as a reference around the office. 
This way you don’t have to have the program running in order to answer a quick question. 

1. Open the AFR Table. 

2. Click the Print Graphic on the toolbar. The Print dialog box appears. 

3. For help using the Print dialog box, click the  in the title bar. 

4. Move the pointer to an item in the dialog box and click again. A Help message appears. 

Save the AFR Data File to Another Location 

You may want to save the AFR data to another location, such as a network. This way, you can 
share the data with others in your office or use the data when working with other programs. 

1. In the AFR Table, click . The Change File Location window appears. 

2. Select the drive and folder in which to save the data file. 
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Calculation Types  

When calculating annuity/life estate/remainder factors or taxable gift values for GRATs, GRUTs, 
and GRITs/QPRTs, you must determine how long the grantor will receive annuities. In other 
words, how long the trust will last. Trusts can be set up for a “term of years or for “life.” 

 
Type Description 

Term If you select term, the grantor receives annuities for a specific number of 
years known as the term. 

Greater If you select greater, you are dealing with two lengths of time: the term of 
the trust and the life of the grantor. If you select greater, the grantor receives 
annuities for the longer of the two lengths of time. 

Shorter If you select shorter, you are dealing with two lengths of time: the term of 
the trust and the life of the grantor. If you select shorter, the grantor receives 
annuities for the shorter of the two lengths of time. 

Life/One Life If you select Life or One Life, the grantor receives annuities until he or she 
dies. 

Joint Life If you select Joint Life, the second-to-die receives annuities until he or she 
dies. 

First-to-Die If you select First-to-Die, annuities stop at the death of the first-to-die. 
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Exhausting Annuities  

The value of an exhausting annuity can be calculated by breaking it down into two separate parts. 
The first part is the portion of the annuity that does not exhaust. The second part is the final 
payment made in the period that the annuity exhausts. 

§25.7520-3(b)(2)(v), example 5 describes a case where a donor, age 60, sets up a $1,000,000 trust 
to pay a 10% annuity for the life of the donor. The §7520 rate used is 6.8%. This annuity is 
calculated to exhaust in 18 years, with a final payment in year 18 equal to $32,712. To value this 
annuity, break it down into two separate parts:  $100,000 lasting for 17 years; and a single 
payment of $32,712 in the 18th year. Once the pieces are known, value each one individually and 
then add them together. The annuity factor for an annuity lasting for the shorter of 17 years or 
until the prior death of a person age 60 is 8.6121. The annuity factor for the shorter of 18 years or 
until the prior death of a person age 60 is 8.7957. Given these factors (which can be obtained 
from example 11 in IRS Pub. 1457), the valuation of the annuity is: 

Value = [ $100,000 x 8.6121 ] + [ $32,712 x (8.7957 - 8.6121) ] 

= $861,210 + $6006 

= $867,216 

Of course, these numbers get more complicated when the annuity is payable more frequently than 
annually, but the basic methodology is still the same. For example, take the above case, but make 
it payable quarterly instead of annually. Now the $100,000 payments only last 16½ years. The 
final payment, made in the 3rd quarter of the 16th year, is $5,414.41. Transforming this single 
payment into an annual amount by multiplying it by the number of payments per year (in this 
case 4), yields an annuity of $21,657.64 lasting 16¾ years. Valuing partial-year annuities requires 
interpolation. An annuity lasting 16½ years is valued by taking ½ the value of the same annuity 
lasting for 16 years plus ½ the value of it lasting for 17 years. An annuity lasting for 16¾ years is 
valued by adding taking ¼ the value of the same annuity lasting for 16 years plus ¾ the value of it 
lasting for 17 years.  

Getting back to the example: 

Annuity Factor for 16½ years   

(½ x 8.4055) + (½ x 8.6121) = 8.5088 

Annuity Factor for 16¾ years   

(¼ x 8.4055) + (¾ x 8.6121) = 8.56045 
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Of course, the frequency of payments still has to be taken into account. The payout frequency 
factor from Table K (IRS Pub. 1457) is 1.0252. Therefore, the annuity is valued: 

Value = 1.0252 x [ $100,000 x 8.5088 ] + [ $21,657.64 x (8.56045 - 8.5088) ] 

= 1.0252 x ($850,880 + $1,118.62) 

= $871,468.99 

The above examples ignore the calculation of both when the annuity exhausts and the amount of 
the final payment. These two numbers, however, are critical to calculating a proper annuity 
valuation. The program provides two different methods for calculating these numbers: the Exact 
Method and the IRS Annuity Factor Method. 

Annuities paid at the beginning of the period are treated in the same manner as annuities paid at 
the end of each period. First, the trust is reduced by the value of the first payment. The above 
analysis is then performed for the annuity, assuming payments occur at the end of each period. 
Finally, the first payment is added to the annuity value. 

Exact Method  

The Exact Method is an intuitive method of calculating the duration and final payment amount of 
the annuity. This method assumes that the annuity grows at a rate equal to the 7520 rate and 
calculates the real payments and growth that would occur each year. The resulting schedule 
returns the exact amount payable in the final period. 

The program defaults to using the IRS Annuity Factor Method. If you select the Exact Method, 
the program will include a schedule illustrating the exhaustion of the trust. When looking at this 
schedule, remember that the interest is compounded annually. Using the above example, the 
growth in the first year would equal 6.8% x $1,000,000 + 6.8% x $900,000 + 6.8% x $800,000 + 
6% x $700,000.  This, of course, assumes that the payments are made at the end of each year. 

Annuity Factor Method         

The IRS Annuity Factor Method is the method the IRS used in §25.7520-3(b)(2)(v), Example 5), 
Example 5. This method finds the highest term that yields a term-certain annuity value less than 
the initial value of the trust. This term is equal to the number of years that full payments last. 
Repeating this technique for the number of periods in the final year gives us the number of 
periods in the final year which have full payments. Once the term of the trust is known, the term 
certain annuity factors are used to calculate the value of the final annuity: 

1) Calculate Term Certain Annuity Factors: 

Factor for 16½ years = (½ x 9.5731) + (½ x 9.8999) = 9.7365 

Factor for 16¾ years = (¼ x 9.5731) + (¾ x 9.8999) = 9.8182 

2) Adjust Annuity Factors for Frequency of Payments: 
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9.7365 x 1.0252 = 9.9818598 

9.8182 x 1.0252 = 10.06561864 

3) Calculate the annuity which corresponds to the final payment: 

 

Annuity =($1,000,000 - ($100,000 x 9.9818598) ) / (10.06561864 – 9.9818598) = $21,657.65 

 
To transform this annuity into a single payment, divide by the number of payments per year:  Final Payment = 
$21,657.65 / 4 = $5,414.41 
 

IRS Notice 89-60 

In Notice 89-60, 1989-1 CB 700, the IRS provides guidance in applying tables containing 
actuarial factors to be used in determining the present value of an annuity, an interest for life or 
for a term of years, or a remainder or reversionary interest. 

Text of Notice 89-60 

In accordance with section 7520 of the Internal Revenue Code, this notice provides tables 
containing actuarial factors to be used in determining the present value of an annuity, an interest 
for life or for a term of years, or a remainder or reversionary interest. The tables set forth in this 
notice apply for valuation purposes under several Code provisions including sections 170, 642, 
664, 2031, 2055, 2512, 2522, and 2624. 

Transitional Rule 

The following discussion is only relevant for Transfer Dates of May or June 1989. Under a 
transitional rule, you may optionally use the new Table Rate with the pre-5/89 life expectancies 
for May 1989 and June 1989 transfers. For example, 5/89 Transfer Dates may use the 5/89 Table 
Rate (with the new life expectancies) or the 3/89 or 4/89 Table Rates (not 10%) with the old life 
expectancies. Similarly, 6/89 Transfer Dates may use the 5/89 or 6/89 Table Rates (with the new 
life expectancies) or the 4/89 Table Rate (not 10%) with the old life expectancies.  

Background 

Section 5031 of the Technical and Miscellaneous Revenue Act of 1988 (Pub. L. No. 100-647, 
102 Stat. 3342 (1988)) amended the Internal Revenue Code by adding section 7520. Generally, 
under section 7520, the value of an annuity, interest for life or for a term of years, or remainder or 
reversionary interest is determined under new tables that are to be prescribed by the Secretary. 
Section 7520 is applicable to gifts and certain other transfers made after April 30, 1989, and to 
estates of decedents dying after April 30, 1989. The new tables prescribed by section 7520 are to 
be based on an interest rate that is 120 percent of the applicable federal midterm rate for the 
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month in which the valuation date falls and the most recent mortality experience available. 
Section 7520(c)(3) provides that, no later than December 31, 1989, the Service must revise 
existing tables to take into account the most recent mortality experience available as of the time 
of such revision. The Service published Notice 89-24, 1989-10 I.R.B. 16, on March 6, 1989, to 
provide temporary guidance to taxpayers in planning transfers that would take place after April 
30, 1989. Notice 89-24 provides formulas for computing the value of transferred interests based 
on the appropriate applicable federal midterm interest rate and the prior mortality experience. 

Interest Rates and Tables for Transfers after April 30, 1989 

The tables set forth below include many single life and term certain factors that are to be used for 
valuing interests in the case of gifts and certain other transfers taking place after April 30, 1989, 
and estates of decedents dying after that date. These new tables reflect the mortality experience 
based on the 1980 census. A complete set of tables, including two life and additional single life 
factors, will be published by the Service in the near future and will be available for purchase from 
the Superintendent of Documents, United States Government Printing Office, Washington, D.C. 
20404.  

The new tables contain factors that are based upon several different interest rates. The appropriate 
factor for any particular transaction will be based on the interest rate the Service announces 
monthly in a news release and publishes in a revenue ruling in the Internal Revenue Bulletin. The 
interest rate for a particular month is the rate that is published as 120 percent of the applicable 
federal midterm rate (compounded annually) in effect under section 1274(d)(1) of the Code for 
the month in which the valuation date falls. That rate is then rounded to the nearest two-tenths of 
one percent. For example, the rate that is published as 120 percent of the applicable federal 
midterm rate (compounded annually) for May 1989 is 11.68 percent. That rate is then rounded to 
the nearest two-tenths of one percent, or 11.6 percent, for purposes of section 7520 of the Code.  

As stated in Notice 89-24, if an income, estate, or gift tax charitable contribution deduction is 
allowed for any part of the property transferred, the taxpayer may use the federal midterm rate for 
the month of the transfer or for either of the two months preceding the month in which the 
valuation date falls. For charitable contributions made in May or June 1989, if the taxpayer elects 
to use the federal midterm rate for either of the preceding two months, which may include March 
and April, the valuation factors for March and April for interests based on the lives of one or 
more individuals will be computed on the basis of Table 1 of United States Life Tables: 1969-71 
and interest at 120 percent of the applicable federal midterm rate for March or April. Thus, the 
March and April actuarial factors (in the case of charitable contributions made in May or June 
1989) will not be based on the new term certain factors and mortality experience.  
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Reg. §25.7520-3(b)(2)(v), Example 5 

This is the actual text from Section 25.7520-3(b)(2)(v). 

Eroding corpus in an annuity trust. The donor, who is age 60 and in normal health, transfers 
property worth $1,000,000 to a trust. The trust will pay a 10 percent ($100,000 per year) annuity 
to a charitable organization for the life of the donor, and the remainder is to be distributed to the 
donor’s child. The section 7520 rate for the month of the transfer is 6.8 percent. Because the 10 
percent annuity payout rate exceeds the 6.8 percent income and growth rate that the trust is 
expected to experience each year, the annuity payout must be assumed to progressively erode the 
corpus. Using an interest rate of 6.8 percent, an annuity payout of $100,000 per year will exhaust 
a $1,000,000 trust corpus in 18 years. The final payment at the end of the 18th year will consist of 
a partial payment of $32,712. Under section 7520, the standard life annuity factors are based on 
the assumption that any person may survive until age 110. This means that the standard life 
annuity factor for age 60 (9.8585) takes into account the separate probabilities that a person age 
60 may survive to receive each of 50 different annuity payments. However, in the present case, 
because of the eroding corpus, the person age 60 can be assumed to receive no more than 17 
$100,000 annuity payments, regardless how long that person might survive. Therefore, the 
standard life annuity factor for a person age 60 (9.8585) is not applicable in this case, and special 
section 7520 annuity factors that take into account the 18-year limitation on the annuity payout 
must be used. The special annuity factor for the present value of the right to receive $1.00 per 
year for 17 years or until the prior death of a person age 60 survives is $.1836. The present value 
of the charitable annuity interest is $867,269 ($100,000 x 8.6121 plus $32,712 x .1836). 
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Treasury Decision 8819 

The IRS has issued temporary and proposed regulations that revise the actuarial tables for valuing 
annuities, interests for life or terms of years, and remainder or reversionary interest to take into 
account the most recent mortality experience available.  

Text of Treasury Decision 8819 

This document contains regulations relating to the use of actuarial tables in valuing annuities, 
interests for life or terms of years, and remainder or reversionary interests. These regulations are 
necessary because section 7520(c)(3) directs the Secretary to update the actuarial tables to reflect 
the most recent mortality experience available. These regulations will effect the valuation of inter 
vivos and testamentary transfers of interests dependent on one or more measuring lives. The text 
of the temporary regulations also serves as the text of the proposed regulations set forth in the 
notice of proposed rulemaking on this subject elsewhere in this issue of the Federal Register.  

Background  

This document contains amendments to the regulations revising certain tables used for the 
valuation of partial interests in property under section 7520 of the Internal Revenue Code of 1986 
(Code) to reflect the most recent mortality experience available.  

In General  

Section 7520, effective for transfers for which the valuation date is after April 30, 1989, provides 
that the value of an annuity, an interest for life or a term of years, and a remainder or reversionary 
interest is to be determined under tables published by the Internal Revenue Service based on a 
discount rate (rounded to the nearest two-tenths of one percent) equal to 120 percent of the 
applicable Federal mid-term rate in effect under section 1274(d)(1) for the month in which the 
valuation date falls. Section 7520(c)(3) directed the Secretary to issue tables not later than 
December 31, 1989, utilizing the then most recent mortality experience. Thereafter, the Secretary 
is directed to revise the tables used in valuing interests dependent on mortality experience not less 
frequently than once each 10 years to take into account the most recent mortality experience 
available as of the time of the revision.  

These regulations incorporate revised Table S (Single Life Remainder Factors) and Table U(1) 
(Unitrust Single Life Remainder Factors) based on data compiled from the 1990 census as set 
forth in Life Table 90CM, and make conforming amendments to various sections to reflect the 
revised tables. The current tables are moved to sections containing actuarial material for historical 
reference. Table B, Table D, Tables F(4.2) through F(14.0), Table J, and Table K, which are not 
based on mortality experience, are not changed. Internal Revenue Service Publications 1457 
“Actuarial Values, Book Aleph (forthcoming 1999), 1458 “Actuarial Values, Book Beth 
(forthcoming 1999), and 1459 “Actuarial Values, Book Gimel (forthcoming 1999) will contain a 
complete set of actuarial tables that include factors not contained in the regulations (for example, 
annuity and life interest factors). Although not available on May 1, 1999, IRS anticipates these 
publications will be available by July 1, 1999. These publications will be available for purchase 
from the Superintendent of Documents, United States Government Printing Office, Washington, 
DC 20402.  
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[[Text omitted here.]] 

Effective Dates  

These regulations are applicable in the case of annuities, interests for life or terms of years, and 
remainder or reversionary interests created after April 30, 1999.  

Transitional Rules  

The regulations provide certain transitional rules intended to alleviate any adverse consequences 
resulting from the proposed regulatory change. For gift tax purposes, if the valuation date of a 
transfer is after April 30, 1999, but before July 1, 1999, the donor may determine the value of the 
gift (and/or any applicable charitable deduction) under tables based on either Life Table 
80CNSMT or Table 90CM (at the donor's option). Similarly, for estate tax purposes, if the 
decedent dies after April 30, 1999, but before July 1, 1999, the value of any interest (and/or any 
applicable charitable deduction) may be determined under tables based on either Table 
80CNSMT or Table 90CM, at the option of the decedent's executor. However, the section 7520 
interest rate utilized is the appropriate rate for the month in which the valuation date occurs. In 
accordance with this transitional rule and those contained in sections 1.7520- 2(a)(2), 20.7520-
2(a)(2) and 25.7520-2(a)(2), in cases involving a charitable deduction, if the valuation date occurs 
after April 30, 1999, and before July 1, 1999, and the executor or donor elects under section 
7520(a) to use the section 7520 interest rate for March 1999 or April 1999, then the mortality 
experience contained in 80CNSMT must be used. If the executor or donor uses the section 7520 
interest rate for May 1999 or for June 1999, then the tables based on either Table 80CNSMT or 
Table 90CM may be used. However, if the valuation date occurs after June 30, 1999, the executor 
or donor must use the new mortality experience contained in Table 90CM even if a prior month 
interest rate election under section 7520(a) is made.  

In addition, for estate tax purposes, the estate of a mentally incompetent decedent may elect to 
value the property interest included in the gross estate under the mortality table and interest rate 
in effect at the time the decedent became mentally incompetent or the mortality table and interest 
rate in effect on the decedent's date of death if the decedent was under a mental incapacity that 
existed on May 1, 1999, and continued uninterrupted until the decedent's death, or the decedent 
died within 90 days of regaining competency after April 30, 1999.  

Special Analysis  

It has been determined that this Treasury decision is not a significant regulatory action as defined 
in EO 12866. Therefore, a regulatory assessment is not required. It also has been determined that 
section 553(b) of the Administrative Procedure Act (5 U.S.C. chapter 5) does not apply to these 
regulations, and because these regulations do not impose a collection of information requirement 
on small entities, the Regulatory Flexibility Act (5 U.S.C. chapter 6) does not apply. Therefore, a 
Regulatory Flexibility Analysis is not required. Pursuant to section 7805(f) of the Internal 
Revenue Code, these regulations will be submitted to the Chief Counsel for Advocacy of the 
Small Business Administration for comment on its impact on small business.  
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Drafting Information  

The principal author of these regulations is William L. Blodgett, Office of Assistant Chief 
Counsel (Passthroughs and Special Industries), IRS. However, other personnel from the IRS and 
Treasury Department participated in their development.  
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Chapter 11 
Getting Help 

If you need help, it’s easy to find. Click the question mark wherever it appears in the program and 
a Help topic will appear. Also, use the Help menu, and if you still need help, Brentmark provides 
technical support. 

Help Menu 

Use the Help menu to find topics in the Help system, learn how to use Help, or view Brentmark 
product information. 

Help System 

The program provides a complete Help system, so you can get help whenever you need it. Just 
click the question mark wherever it appears in the program. Use the Help system’s table of 
contents to view Help topics by category or search the Help index for specific terms. 

Technical Support       

Technical Support is available by telephone, fax, e-mail, or postal mail. If you have questions 
concerning program calculations, please have a list of your exact data entry values available when 
contacting us. 

Telephone 

Assistance by telephone is available Monday through Friday between 9:00 AM and 6:00PM 
Eastern Standard Time at (407) 306-6160. 

Fax 

For assistance by fax, send your fax to (407) 306-6107. 

E-mail 

For assistance via e-mail, send your remarks to support@brentmark.com. 
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Postal Mail 

For assistance by postal mail, write to: 

 
Brentmark Software, Inc. 
3505 Lake Lynda Drive, Suite 212 
Orlando, FL 32817-8327 

In your correspondence, please include the following information: 

• The name to which the program is registered. 

• A contact phone number. 

• The program name and version number. 

• Your system configuration. 

• A sample printout or description of the problem. 

• A list of any error messages that have appeared. 

 

Program Updates 

From time to time, Brentmark will update the program due to tax law changes or new features. 
We post minor updates on our website at www.brentmark.com. We send major updates to all 
registered users who have up-to-date maintenance. Licensing the program automatically registers 
the program. 
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License Agreement   
 
This software is protected by both United States copyright law and international treaty provisions.  You 
must treat this software just like a book, except that you may copy it onto a computer to be used and you 
may make archival copies of the software for the sole purpose of backing up our software and protecting 
your investment from loss. You must also agree not to reverse engineer the software. 
 
By saying “just like a book,” Brentmark means, for example, that this software may be used by any number 
of people, and may be freely moved from one computer location to another, so long as there is no 
possibility of it being used at one location or on one computer while it is being used at another.  Just like a 
book cannot be read by two different people in two different places at the same time, neither can the 
software be used by two different people in two different places at the same time (unless, of course, 
Brentmark's copyright is being violated).   
 
Limited Warranty 
Brentmark Software, Inc. warrants the physical diskette(s) and physical documentation enclosed herein to 
be free of defects in materials and workmanship for a period of sixty days from the purchase date.  If 
Brentmark receives notification within the warranty period of defects in materials or workmanship, and 
such notification is determined by Brentmark to be correct, Brentmark will replace the defective diskette(s) 
or documentation.   
 
The entire and exclusive liability and remedy for breach of this Limited Warranty shall be limited to 
replacement of defective diskette(s) or documentation and shall not include or extend to any claim for or 
right to recover any other damages, including but not limited to, loss of profit, data or use of the software, 
or special, incidental or consequential damages or other similar claims, even if Brentmark has been 
specifically advised of the possibility of such damages. In no event will Brentmark's liability for any 
damages to you or any other person ever exceed the lower of suggested list price or actual price paid for the 
license to use the software, regardless of any form of the claim.   
 
BRENTMARK SOFTWARE, INC. SPECIFICALLY DISCLAIMS ALL OTHER WARRANTIES, 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO, ANY IMPLIED WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.  Specifically, Brentmark makes 
no representation or warranty that the software is fit for any particular purpose and any implied warranty of 
merchantability is limited to the sixty day duration of the Limited Warranty covering the physical 
diskette(s) and physical documentation only (and not the software) and is otherwise expressly and 
specifically disclaimed.   
 
The limited warranty gives you specific legal rights; you may have others which may vary from state to 
state.  Some states do not allow the exclusion of incidental or consequential damages, or the limitation on 
how long an implied warranty lasts, so some of the above may not apply to you.   
 
Governing Law and General Provisions 
The License Statement and Limited Warranty shall be construed, interpreted and governed by the laws of 
the State of Florida and any action hereunder shall be brought only in Florida.  If any provision is found 
void, invalid or unenforceable it will not affect the validity of the balance of this License and Limited 
Warranty which shall remain valid and enforceable according to its terms.  If any remedy hereunder is 
determined to have failed of its essential purpose, all limitations of liability and exclusion of damages set 
forth herein shall remain in full force and effect.  This License and Limited Warranty may only be modified 
in writing signed by you and a specifically authorized representative of Brentmark.  All rights not 
specifically granted in this statement are reserved by Brentmark.   
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